
1CodePilot (Ver. 5.0)-IV (Answer Key)

=  

.Answer Key
 

Class

4

CodePilot (5.0)

 Computer Memory

LEARNING LOGS

A.	 1. (iv)		  2. (i)			  3. (iii)		  4. (i)			  5. (ii)
B.	 1. T		  2. T			   3. F			   4. F			   5. F
C.	 1. USB		  2. 8			   3. RAM, ROM			   4. Memory Card
	 5. Cloud
D.	 1.	� Computer memory is a space where a computer stores information that it needs to remember                                                 

both for a short and a long time.
	 2.	� Primary memory is also known as Internal memory. It is considered as the main memory which 

can be easily accessed by the computer. It stores the data and instructions the computer 
uses.

	 3.	The differences between RAM and ROM are as follows:

RAM ROM

It stands for Random Access Memory. It stands for Read-only Memory.

It is a volatile memory. It is a non-volatile memory.

	 4.	The storage capacity of secondary storage devices are as follows:
	 	 •  External Hard Disk comes in various sizes like 256 GB, 512 GB, 1 TB and more.
	 	 •  Pen Drive comes in different sizes like 4 GB, 8 GB, 16 GB and more.
	 5.	� Cloud storage is a service that allows you to store your files on the Internet instead of on a 

physical device like mobile phone, computer, etc. Cloud storage allows you to access your 
files from any location using Internet. For example, Dropbox, iCloud, Google Drive, etc.

1.
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Do it yourself.

�

Do it yourself.

Periodic Assessment-1
(Based on chapters 1 & 2)

A.	

B.	 1.	File						      2 		 a.  Shows files and folders

	 2.	File Explorer				    5 		 b.  Change system settings

	 3.	Primary Memory				   4 		 c.  Permanent in nature

	 4.	Secondary Memory			   1 		 d.  Collection of data or information

	 5.	Control Panel				    3 		 e.  Internal memory
C.	 1.	Folder
	 2.	Deleted
	 3.	Documents
	 4.	Operating System
	 5.	File extension

LAB LEARNING

CODE CHECK

	 1.	The game is using RAM (Random Access Memory).
	 2.	She should use an External Hard Disk.

Do it yourself.

�

Do it yourself.

 Files and Folders in Windows 11

LEARNING LOGS

A.	 1. (iii)		  2. (i)			  3. (ii)			  4. (ii)			  5. (iv)
B.	 1. F		  2. T			   3. F			   4. T			   5. T
C.	 1. Rename	 2. Left pane	 3. Period (.)	 4. Folder		  5. File Explorer
D.	 1.	A file is a collection of data or information stored on a computer or other digital device.
	 2.	� Temporary files are made by software and the operating system to hold data for a short time 

while tasks run.
	 3.	� The Control Panel in Windows is used to view and change system settings. It provides one 

place to manage hardware, software, security, network and other computer settings.
	 4.	The steps to restore a deleted file are as follows: 
		  1   Double-click on the Recycle Bin icon on the Desktop.
		  2   Right-click on the file in the Recycle Bin that needs to be restored.
		  3   Select the Restore option.
	 5.	� Copying a file or folder creates a duplicate in a new location while keeping the original 

unchanged. Moving a file or folder transfers it to a new location and the original is no longer 
in the old place.

	 1.	Disk Cleanup / Delete Temporary Files tool
	 2.	Date and Time option in the Clock and Region setting of Control Panel.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK

2.

COMPETENCY-BASED QUESTIONS
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Do it yourself.

�

Do it yourself.

Periodic Assessment-1
(Based on chapters 1 & 2)

A.	

B.	 1.	File						      2 		 a.  Shows files and folders

	 2.	File Explorer				    5 		 b.  Change system settings

	 3.	Primary Memory				   4 		 c.  Permanent in nature

	 4.	Secondary Memory			   1 		 d.  Collection of data or information

	 5.	Control Panel				    3 		 e.  Internal memory
C.	 1.	Folder
	 2.	Deleted
	 3.	Documents
	 4.	Operating System
	 5.	File extension

LAB LEARNING

CODE CHECK
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 Word Beyond the Basics

LEARNING LOGS

A.	 1. (ii)		  2. (ii)			  3. (iii)		  4. (i)			  5. (ii)
B.	 1. T		  2. T			   3. F			   4. F			   5. T
C.	 1. Red		  2. Direction	 3. Through	 4. WordArt	 5. Ungrouping
D.	 1.	� Text wrapping is one of the special features present in Word that allows the text to move 

around the picture or object.
	 2.	Footer displays details at the bottom, such as page numbers and document version.
	 3.	The Thesaurus feature enhances vocabulary by providing synonyms and antonyms for words.
	 4.	� SmartArt in Word allows you to create professional diagrams to visually present ideas such 

as processes, hierarchies, relationships, cycles and lists.
	 5.	The steps to apply a style to an image are as follows:
		  1   Select the image.
		  2   Click on the Quick Styles option under the Picture Format tab.
		  3   Choose the style you want to apply to your image.
.

	 1.	SmartArt feature of Word should be used.
	 2.	� Hemant should select the picture and go to Wrap Text options. He can choose Square, Tight 

or Through to make text appear around the picture. This will move the text from behind the 
picture and flow alongside it.

Do it yourself.

�
Do it yourself.

4.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK

 Sketchpad Advanced Art Skills

LEARNING LOGS

A.	 1. (iv)		  2. (i)			  3. (iii)		  4. (iii)		  5. (ii)
B.	 1. F		  2. T			   3. F			   4. F			   5. T
C.	 1. Sketchpad	 2. Hidden		 3. Pattern		 4. Star		  5. Layer
D.	 1.	Hamburger icon option are as follows:
		  a. Send to Back: Moves the layer behind others. 
		  b. Send to Front: Moves the layer slightly in front of another. 
		  c. Send Backwards: Moves the layer all the way to the back.
	 2.	Eyeball Icon is used to show or hide a layer.
	 3.	The Mirror Brush is a digital tool used to make symmetrical designs.
	 4.	Types of backgrounds are as follows:
		  a. Solid: To keep the focus on the main elements of the drawing. 
		  b. Linear: A smooth transition from one colour to another.
	 5.	� Layers are like clear plastic sheets stacked on top of each other in a drawing. Each layer holds 

a different part of your artwork which help you keep your drawing neat and organised.

	 1.	The Mirror Brush tool.
	 2.	Aditi can simply drag the layer up or down in the Layers Panel to reorder it correctly.

Do it yourself.

�
Do it yourself.

3.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK
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 Word Beyond the Basics

LEARNING LOGS

A.	 1. (ii)		  2. (ii)			  3. (iii)		  4. (i)			  5. (ii)
B.	 1. T		  2. T			   3. F			   4. F			   5. T
C.	 1. Red		  2. Direction	 3. Through	 4. WordArt	 5. Ungrouping
D.	 1.	� Text wrapping is one of the special features present in Word that allows the text to move 

around the picture or object.
	 2.	Footer displays details at the bottom, such as page numbers and document version.
	 3.	The Thesaurus feature enhances vocabulary by providing synonyms and antonyms for words.
	 4.	� SmartArt in Word allows you to create professional diagrams to visually present ideas such 

as processes, hierarchies, relationships, cycles and lists.
	 5.	The steps to apply a style to an image are as follows:
		  1   Select the image.
		  2   Click on the Quick Styles option under the Picture Format tab.
		  3   Choose the style you want to apply to your image.
.

	 1.	SmartArt feature of Word should be used.
	 2.	� Hemant should select the picture and go to Wrap Text options. He can choose Square, Tight 

or Through to make text appear around the picture. This will move the text from behind the 
picture and flow alongside it.

Do it yourself.

�
Do it yourself.

4.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK
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	 5.	The storage capacity of secondary storage devices are as follows: 
	 	 • External Hard Disk comes in various sizes like 256 GB, 512 GB, 1 TB and more. 
	 	 • Pen Drive comes in different sizes like 4 GB, 8 GB, 16 GB and more. 
     	 6.	The steps to apply a style to an image are as follows:
		  1   Select the image.
		  2   Click on the Quick Styles option under the Picture Format tab.
		  3   Choose the style you want to apply to your image.
	 7.	� Temporary files are made by software and the operating system to hold data for a short time 

while tasks run.
	 8. The Mirror Brush is a digital tool used to make symmetrical designs.

 PowerPoint Made Easy

LEARNING LOGS

A.	 1. (ii)		  2. (iv)		  3. (iv)		  4. (i)			  5. (ii)
B.	 1. F		  2. T			   3. T			   4. F			   5. T
C.	 1. Slide		  2. Title Bar	 3. Esc		  4. Notes		  5. Nine
D.	 1.	A presentation is a way to share ideas using slides that include text, images or videos.
	 2.	� Slide layout defines the arrangement of placeholders for text, images and other content on 

a slide.
	 3.	The description of PowerPoint components is as follows:
		  a. Quick Access Toolbar: Customisable icons for frequently used commands.
		  b. Title Bar: Shows the file name.
	 4.	To add a new slide, follow the given steps:
		  1   Click on the Insert tab. 
		  2   Click on the New Slide drop-down arrow.
		  3   Select the desired slide layout.
	 5.	The text alignment options in PowerPoint are as follows:
		  a. Align Left: Aligns the text to the left side of the slide.
		  b. Align Right: Aligns the text to the right side of the slide.
		  c. Center: Aligns the text in the middle of the slide.
		  d. Justify: Aligns the text evenly on both sides.

5.

Periodic Assessment-2
(Based on chapters 3 & 4)

A.	 1. Resize			   2. Rotate			   3. WordArt

B.	 1.	Resizing				    3 		 a.  Visually present ideas

	 2.	Rotating				    4 		 b.  Synonyms and antonyms

	 3.	SmartArt				    1 		 c.  Adjusting width and height

	 4.	Thesaurus				    2 		 d.  Turning the image

C.	 1. Layers
	 2. Background	
	 3. Rangoli
	 4. Clipart	
	 5. Images

Test Sheet-1
(Based on chapters 1 to 4)

A.	 1. (i)		   2. (i)				   3. (ii)				   4. (iii)
	 5. (ii)		  6. (ii)	
B. 	 1. T		  2. F				    3. T				    4. T
	 5. T		  6. F				    7. T				    8. T
C. 	 1. Direction		  2. Period (.)		  3. RAM, ROM		  4. Hidden
	 5. File Explorer		 6. 8				    7. Red			   8. Folder
D. 	 1.	� Footer displays details at the bottom, such as page numbers and document version.
	 2.	� Primary memory is also known as Internal memory. It is considered as the main memory which 

can be easily accessed by the computer. It stores the data and instructions the computer 
uses.

	 3.	� Copying a file or folder creates a duplicate in a new location while keeping the original 
unchanged. Moving a file or folder transfers it to a new location and the original is no longer 
in the old place.

	 4.	Types of backgrounds are as follows:
		  a. Solid: To keep the focus on the main elements of the drawing. 
		  b. Linear: A smooth transition from one colour to another.
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	 5.	The storage capacity of secondary storage devices are as follows: 
	 	 • External Hard Disk comes in various sizes like 256 GB, 512 GB, 1 TB and more. 
	 	 • Pen Drive comes in different sizes like 4 GB, 8 GB, 16 GB and more. 
     	 6.	The steps to apply a style to an image are as follows:
		  1   Select the image.
		  2   Click on the Quick Styles option under the Picture Format tab.
		  3   Choose the style you want to apply to your image.
	 7.	� Temporary files are made by software and the operating system to hold data for a short time 

while tasks run.
	 8. The Mirror Brush is a digital tool used to make symmetrical designs.

 PowerPoint Made Easy

LEARNING LOGS

A.	 1. (ii)		  2. (iv)		  3. (iv)		  4. (i)			  5. (ii)
B.	 1. F		  2. T			   3. T			   4. F			   5. T
C.	 1. Slide		  2. Title Bar	 3. Esc		  4. Notes		  5. Nine
D.	 1.	A presentation is a way to share ideas using slides that include text, images or videos.
	 2.	� Slide layout defines the arrangement of placeholders for text, images and other content on 

a slide.
	 3.	The description of PowerPoint components is as follows:
		  a. Quick Access Toolbar: Customisable icons for frequently used commands.
		  b. Title Bar: Shows the file name.
	 4.	To add a new slide, follow the given steps:
		  1   Click on the Insert tab. 
		  2   Click on the New Slide drop-down arrow.
		  3   Select the desired slide layout.
	 5.	The text alignment options in PowerPoint are as follows:
		  a. Align Left: Aligns the text to the left side of the slide.
		  b. Align Right: Aligns the text to the right side of the slide.
		  c. Center: Aligns the text in the middle of the slide.
		  d. Justify: Aligns the text evenly on both sides.

5.
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	 1.	� Fahad can use the Zoom Slider (at the bottom-right corner of the PowerPoint window) or 
the Zoom option under the View tab to magnify or reduce the slide details.

	 2.	Kamakshi can press the Esc key to exit the slideshow.

Do it yourself.

�

Do it yourself.

 Safe and Smart Web Use

LEARNING LOGS

A.	 1. (ii)		  2. (i)			  3. (iii)		  4. (ii)			  5. (ii)	
B.	 1. F		  2. T			   3. T			   4. F			   5. T
C.	 1. Web Browser		  2. Online Safety		  3. Forward
	 4. Refresh			   5. Google Chrome
D.	 1.	� Uses of web browser are as follows:
		  a.  Read books and articles.
		  b. Connect with friends and family via social media or video conferencing.
	 2.	� Copilot is a AI tool that answers questions, helps write stories and creates pictures from 

descriptions.
	 3.	� Online safety is about protecting yourself and your personal information on the Internet. 

following online safety rules helps keep you safe while browsing, chatting or playing games.
	 4.	Ways to stay safe from strangers online are:
		  a. Don’t reply to messages from strangers.
		  b. If someone keeps trying to talk to you, block and report them on the website or app.
	 5.	� Cyberbullying occurs when someone is unkind or harmful to others online, through messages, 

posts or comments. To avoid it:
		  a. Don’t respond to mean messages. 
		  b. Inform a parent or teacher.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK

6.

	 1.	Mahesh should use extension.
	 2.	Ameera should type the website URL or search term in the Address Bar to access the site.

Do it yourself.

�
Do it yourself.

Periodic Assessment-3
(Based on chapters 5 & 6)

A.	 1.	Google Chrome			   2. Safari			   3. Mozilla Firefox		  4. Microsoft Edge
B.	 1.	Left Align				    2. View buttons	 3. Slides Pane			   4. Center Align  
C.	

Quick Access Toolbar Title Bar

Ribbon

SlideSlides/Outline Pane

Placeholder

Zoom SliderStatus Bar

Notes Comments View Buttons

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK
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	 1.	Mahesh should use extension.
	 2.	Ameera should type the website URL or search term in the Address Bar to access the site.

Do it yourself.

�
Do it yourself.

Periodic Assessment-3
(Based on chapters 5 & 6)

A.	 1.	Google Chrome			   2. Safari			   3. Mozilla Firefox		  4. Microsoft Edge
B.	 1.	Left Align				    2. View buttons	 3. Slides Pane			   4. Center Align  
C.	

Quick Access Toolbar Title Bar

Ribbon

SlideSlides/Outline Pane

Placeholder

Zoom SliderStatus Bar

Notes Comments View Buttons

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK
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 Vision to Decision

LEARNING LOGS

A.	 1. (ii)		  2. (iii)		  3. (i)			  4. (i)			  5. (iv)
B.	 1. T		  2. T			   3. F			   4. F			   5. T
C.	 1. Spot		  2. Visual clues		 3. Seeds 			   4. Coordinates
	 5. Buildings
D.	 1.	� Visual processing is how the brain understands and interprets what you see. When you look 

at something, your eyes send information to your brain.
	 2.	� Infographic is a visual representation of information. It uses a combination of pictures, symbols 

and concise text.
	 3.	A green traffic light means go, a red means stop and a yellow means wait.
	 4.	� Sudoku is a popular puzzle game where you fill a grid with numbers or images. The goal is to 

place a number or image in each cell so that it appears only once in every row and column. 
	 5.	� What repeats? How often does it repeat? Can I guess what comes next? 

	 1.	Nagarjun should stop and wait because a red traffic light means stop.
	 2.	� Riya cannot place the number 5 in that box because Sudoku rules allow each number only 

once per row and column.

Do it yourself.

�
Do it yourself.

7.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK
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 Scratch Coding Adventures

LEARNING LOGS

A.	 1. (iii)		  2. (i)			  3. (iii)		  4. (iii)		  5. (i)
B.	 1. Vector 		 2. Erase All	 3. Events		  4. Hide		  5. Coding

C.	 1.	 					    5 		 a.  C-Block

	 2.	 					    4 		 b.  Reporter Block

	 3.	 			   1 		 c.  Hat Block

	 4.	 				    2 		 d.  Stack Block

	 5.	 				    3 		 e.  Boolean Block

D.	 1.	Sound blocks are as follows:
		  a. �play sound [Meow] until done – Plays the sound and waits until it finishes before continuing 

the script.
		  b. start sound [Meow] – It is used to play the selected sound without pausing the script.
	 2.	� These blocks have notch at the top and bumped bottom. They stack on top of each other 

to tell the sprite what to do, like move, turn or say something.
	 3.	� Custom costumes are different appearances you can assign to a sprite using tools in the 

Costumes tab.
	 4.	� Comparison operator allow you to compare the relationship between two values or variables. 

It will compare two numbers and decide whether it is true or false. Comparison operators 
are used with the if... then block.

8.
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	 5.	Difference between the ‘if then’ and ‘if then else’ blocks are as follows:

        If then block          If then else block 

Checks if a condition is true. If yes, 
it performs the action. If not, it does 
nothing.

Checks a condition and performs one action 
if it’s true or a different action if it’s false.

	 1.	� Vikram should use the division ( / ) operator block to divide the candies equally among 4 
friends.

	 2.	� Jiya should use the “think [message] for [seconds]” block to show a thought bubble with a 
message.

Do it yourself.

�
Do it yourself.

 Smart World with AI

LEARNING LOGS

A.	 1. (ii)		  2. (iii)		  3. (iv)		  4. (i)			  5. (ii)
B.	 1. Smart cities			  2. Energy		 3. Drones
	 4. Software			   5. Google Assistant
C.	 1. T		  2. F			   3. T			   4. F			   5. T
D.	 1.	� Autonomous transportation means self-driving vehicles that use AI, sensors and cameras to 

follow traffic rules, control speed and avoid obstacles without human help.
	 2.	� A virtual assistant is a software that uses AI to perform tasks through voice or text. Examples 

include Siri, Alexa and Google Assistant.
	 3.	� AI helps the military by improving operations. AI-powered drones are used for spying and 

targeting. Self-driving military vehicles, like tanks and trucks, can move without humans, 
making work safer and more efficient in dangerous areas.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK

9.

	 4.	Two uses of AI in daily life:
	 	 (i) AI makes homes smarter by controlling devices like lights, thermostats.
	 	 (ii) Google Maps use AI to give real-time traffic updates, suggest the fastest routes.
	 5.	Two ways AI helps in healthcare:
	 	 (i)  Analyses medical images like X-rays and MRIs to detect diseases such as cancer or fractures.
	 	 (ii Creates personalised treatment plans based on a patient’s health history and genetics.

	 1.	Kimaya can use Google Maps, which uses AI to suggest faster alternative routes in real-time.
	 2.	Priya is using a Smart Home device (AI-powered smart appliances like a smart thermostat).

Do it yourself.

�
Do it yourself.

Periodic Assessment-4
(Based on chapters 7 to 9)

A.	

B.	 1.	 and 				    3 		 a.  Events Block

	 2.	 ?touching color 			   4 		 b.  Control Block

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK
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	 4.	Two uses of AI in daily life:
	 	 (i) AI makes homes smarter by controlling devices like lights, thermostats.
	 	 (ii) Google Maps use AI to give real-time traffic updates, suggest the fastest routes.
	 5.	Two ways AI helps in healthcare:
	 	 (i)  Analyses medical images like X-rays and MRIs to detect diseases such as cancer or fractures.
	 	 (ii Creates personalised treatment plans based on a patient’s health history and genetics.

	 1.	Kimaya can use Google Maps, which uses AI to suggest faster alternative routes in real-time.
	 2.	Priya is using a Smart Home device (AI-powered smart appliances like a smart thermostat).

Do it yourself.

�
Do it yourself.

Periodic Assessment-4
(Based on chapters 7 to 9)

A.	

B.	 1.	 and 				    3 		 a.  Events Block

	 2.	 ?touching color 			   4 		 b.  Control Block

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK
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	 3.	 when clicked 	 				    1 		 c.  Operators Block

	 4.	
repeat 10

				    2 		 d.  Sensing Block

C.		  1. Siri
		  2. Google Assistant
		  3. Alexa

Test Sheet-2
(Based on chapters 5 to 9)

A.	 1. (iii)		  2. (i)			  3. (i)	 		  4. (i) 			  5. (iv)		  6. (i)
B.	 1. F		  2. T			   3. T			   4. T			   5. T
	 6. F		  7. T			   8. F
C.	 1.	Forward			   2. Coding blocks		  3. Title Bar		  4. Visual clues
	 5. Software			   6. Energy				   7. Vector			   8. Esc
D. 	 1.	� Comparison operator allow you to compare the relationship between two values or variables. 

It will compare two numbers and decide whether it is true or false. Comparison operators 
are used with the if... then block.

	 2.	Ways to stay safe from strangers online are:
	 	 a. Don’t reply to messages from strangers.
	 	 b. If someone keeps trying to talk to you, block and report them on the website or app.
	 3.	� AI helps the military by improving operations. It uses AI-powered drones for spying and 

targeting and self-driving military vehicles make work safer and more efficient in dangerous 
areas.

	 4.	A green traffic light means go, a red means stop and a yellow means wait.
	 5.	To add a new slide, follow the given steps: 
	 	 1   Click on the Insert tab. 
	 	 2   Click on the New Slide drop-down arrow. 
	 	 3   Select the desired slide layout.
	 6.	� Visual processing is how the brain understands what you see. Your eyes send information 

and the brain identifies it — like seeing a dog and knowing it’s a dog.
	 7.	The description of PowerPoint components is as follows:
	 	 a. Quick Access Toolbar: Customisable icons for frequently used commands.
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	 	 b. Title Bar: Shows the file name.
	 8.	� Cyberbullying occurs when someone is unkind or harmful to others online, through messages, 

posts or comments. To avoid it: 
	 	 a. Don’t respond to mean messages. 
	 	 b. Inform a parent or teacher.


